Hydrographe ! Une carriere d’avenir CIDCO

Activité : Mission Alcor / Traitement

Objectif : procéder au traitement des données bathymétriques acquises sur la zone de
I'échouement de I'Alcor.

Contexte : I’étudiant se voit fournir un jeu de données bathymétriques acquises sur la zone de
|'échouement de I'Alcor par une équipe du Service Hydrographique du Canada.

Logiciel : Caris HIPS&SIPS

Exercice :
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Hydrographe ! Une carriere d’avenir CIbCOo
1. Charger le jeu de données bathymétriques acquis
Open Project ﬂ File Edit Wew Tools
_D e
— Qpen Praoject. ..
Clic droit dans la fenétre Connect Ta,.,
Projects : Cisconnect
= Connect To... Edit. ..
Name : Alcor =

Folder : Naviguer jusqu’au
répertoire HDCS_Data du
projet Alcor

Mare: I Blcor

Faolder: I F:\Projetsi1213-723 Nu:uva-Science_Sensil:uilisaticuI

84 |

Cancel

éﬁ Projetalcor

B 1-Dacument ation
|53 2-Planification
I 3-Acquisition
=l L5 4-Traitement

= ) HIPS7L

| Background
|E| BearnPattern
|5 Fieldsheets

L
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Hydrographe ! Une carriere d’avenir CIDCO

"“JCARIS HIPS and SIPS =imx]
[lFile Edt View Todls Process Select window Help ;Iilﬁl‘

Dezdlimel-iole||=@E=ax KXo ===~
-

77 ||aaae=s@|x]
[Zhalsynce bt xsam|=lar=7 [asiTdedds B

2l
=0 Aloor B
Db GLO3
=h 1999327

[£7] 991809132731 s0n.0001 b
-57] 991809132731.50n.0002
[77] 931809132731 s0n.0003
4] 991809132731.20n.0004
7] 931803132731 5000005
7] 991809132731 son. 0006
-t57] 991809132731.50.0007
{7 991809132731 s0n.0008
-27] 991809132731.50n.0003
{77 931809132731 s0n.0010
{4 99i809132731.20n.0011 LI

77 AR AR o e

2 Project [ Lavers | [} Draw rder

TP oI output 4 Selection

=
B General
Symbolize lines ™ False
Symbols TRACK_LINE
Liree Weight 0
Bl Colour
Merged [so, 255, 50
Mok merged R
Multiple colours I™ False
Colour files Trackline
Colour by S Profile ™ False
Ready [OoffOsdecied  [15688  [TO27178N  [704543EAW

2. Créer une premiere Surface Base / visualisation du jeu de
données

Process |Er|:u:ess Select  Window
= New [
Field

Sheet

Enseignement supérieur,
Recherche, Science
et Technologie

P £33
Quebec E3E3  Cégep Limoilou

“
Péches et Ocsans  Fisheries and Oceans C r ’
". I Canada Canada a ’S




Hydrographe ! Une carriere d’avenir CIbCOo

Directory :
Naviguer jusqu’au
répertoire
FieldSheets du

Mew Field Sheet (Step 1 of 3}

Directony: |F:‘»F'r|:|iets'\1 213723 Nnva-Science_l Browsze. .

-REZ 4

projet Alcor Exizting Field Sheets d

Name :
Nad83 _UTM19

tMame: [Madi3_UTHM14

Scale 1: I'IEIEIEIEI
Harizontal FRezolution: IEI.EIE i
Depth Rezolution: IEI.EIEI'I m

<Erécédent| Suivant = I Annuler | Aide

% Projetalcor

B 1-Documentation
[ 2-Planification
I 3-Acquisition
=l ) 4-Traitement

=l L5 HIPS7L

I Background
[h BearnPattern
= 1 FEEERE
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Hydrographe ! Une carriere d’avenir CIDCO
Group : UTM - New Field Sheet {Step 2 of 3)
NADS83
Zone : UTM-19N-
Nad83 Group :l £one |ﬂ
Mew Zealand [M22K) ITH-145-MNads3
Morth America AT H-15M M add3
Peru ITH-155-NadB83 _‘
Philippines ITH-16M-Mad33
[ atar ITH-165-Nads3
Switzerland ATH-17H - add3

I1.5. State Plane 1927
I1.5. State Plane 1333

LUTH - MADZT
LUTH - MADEZ
UTH -'wWGES54

KN

UFS - Univer. Palar Sterec
UTH - Clarke 1865 J

.

UTH-175-Madd3
UTH-18M-Mad83
LITH-185-Nadd3
LITH-130 - ad83
LUTH-135-Mad33
LITH-20M-M adB83

[ ]

IEDnE 190 [72 % TO BB ')

<Erécédent| Suivant I

Annuler | Aide

New Field Sheet {Step 3 of 3)

— Field Sheet Extents
d: 0 0
E: 000: 00 00

¥ Geographic

i~ Ground

;000000
E - 000:00:00

0.00 m

0.00 m

Field Sheet Area

m;nn;nn;nu

E:000:00:00

|N 00 o o

E:000:00:00

.
N

4

< Précédent I Terminer I Annuler | Ajde
Sélectionner le
FieldSheet =1 vl Iy HIPS Data
Nad83 UTM19 Pobe ship Track Lines
P Pobe (1B Contacts
dans la fenétre 5 VI
Control (onglet e e
Layers)
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Hydrographe ! Une carriere d’avenir

CIDCO

Process | Process Select Window Help
- Base Mew Field Sheet —, e
Surface e | K
5> N |T Set as Active Field Sheet . .
ew... ]
— |5 ah db
il Load True Heave. ..
b [oad Delea Draft, . 21zl
& Load[Tide, . =
LLoad GEtitudeNavigation data, .,
Load Error; data,. .,
|4_E|I Compute TR, ..
% Compute GRS Tide, .
b Sound Yelocity Correckion,. .
? [MErge. ..
Name : SA_1m BASE Surface Wizard (Step 1 of 3) x|
—BASE Surface
Surface Mame: [S4_Tm
 Comments
=
=
< Brécédent I Suivant > I Anrwler | Aide |

CIDCO
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Hydrographe ! Une carriere d’avenir

CIDCO

Resolution BASE Surface Wizard (Step 2 of 3) x|
Single : 1m
Surface Type : ~ Resolution
Swa'FhAngIe & Single: |1|— o
Vert'cal Datum . minDepth.maHDepth
Unknown [ Depth Filter: I
minDepthlm] - maxDepthlm]. res(m]
" Multiple: |
Load... Save...
Surface Type: Swath Angle <
Yertical Datum; | Unknown v
< Précédent I Suivant > I Anrwler | Aide |
BASE Surface Wizard (Step 3 of 3) x|
—Add survey lines
td & footprint zize: = =9 pizelz
[T Use zelected inez [ lgnare lines with emars
Include status:
v iccepted W Examined W Outstanding
- Additional Attibutes
v Denzity W Mean [V Standard Deviation
¥ Shoal ¥ Deep
b amimurm File Size:  39.8 kE
< Préceédent I T erminer I Anruler Aide
View |View Tools Process
=> Refresh
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Hydrographe ! Une carriere d’avenir CIDCO

& Comment expliquez-vous les trous dans la Surface ?

3. Analyser le jeu de données

& On remarque que la Surface Base est entachée de deux problémes d’acquisition.
Lesquels ?

Probléme d’acquisition #1

Probleme d’acquisition #1

On remarque égaiement gue ia position de I’échouement (rectangle noir sans donnée), ne
correspond pas a la position donnée pour initier la planification.
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Hydrographe ! Une carriere d’avenir CIDCO

Open Background Data 'File Edit ‘Wiew Tools Process

e

']

(= Spen Project. ..
Close Projeck
S

=
I 3

Jpen Session, ..
Save Session
Save Session As...,

Claose Session

Cpen Field sheets. ..

Open Background Data. ..

Naviguer jusqu’au fichier
CA479025.000

Name : 5-57 ENC3.1 x|

Ok Marne:
Id:
Wersion: I Z.0
Prafile: I CCARISVHIPS 71 Syskemnt S5 7 Confighsystem S5 73 1Prof

Dickionaries: | C:WCARISYHIPSY? 13 Syskemt 557 Confighsystem|s5731Pool,

4] | 2
camel_|

ok 5-57 Update Options x|

Mo updates were Found,

[ Locate Updates

I Browse, ., |

- Cutput 5-57 update messages

Beqin at update numl:uer:l TI

Cancel |
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Hydrographe ! Une carriere d’avenir CIDCO

Réarranger I'ordre des CA47I025:CA4TI025
calques dans la fenétre [Z] Mada3_uTmig
Control (onglet Draw <0 Nads3_UTM19:54_3m_MoMation:Depth
Order)
View | Yiew Tools Process
=» Refresh

En effet, la position donnée pour initier la planification correspond a la position du 1%
échouement, soit la position transmise par le capitaine de I’Alcor a la station « Radio Garde
Cotiere » de Québec. Cependant, deux échouements subséquents ont eu lieu suite a des
manceuvres de renflouement avortées. Le levé bathymétrique a été réalisé suite au 3°™
échouement.
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Hydrographe ! Une carriere d’avenir CIDCO

gl PRI a N
& 4 é - S
I

CHICOUTIMI

A7 _/_} Q UE BE
5 TROIS-RIVIER
g MONTREA

T e - # ,
}_ﬁ;f,-?'f—"" < = g
T
g ALCOR

9 novembre 1999 15h00 |
9 novembre 1999 19h30 |-
0 novembre 1999 19h45

Ty

-1
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Hydrographe ! Une carriere d’avenir

4. Corriger les données pour le probleme d’acquisition #1

(marées)

4.1. Identifier la date et ’heure du lever

CIbCO

Sélectionner la 1% | =02 Alear

ligne de sondage -l GLO3
dans la fenétre
Control (onglet

Project)

Regarder les Pro... - | vessel | Day | Line |
attributs pour la Alcor EC03 1999-327  99i80913... 1999-11-23 16:44:30.000
ligne sélectionnée

dans la fenétre 4 I |
Worksheet (onglet FIEI | Hr\. Ciutput }H.Selectinn {r

Selection)

En interrogeant de la méme maniére la derniére ligne de sondage, on constate que le levé s’est

déroulé le 23 novembre 1999 entre 16h44 et 22h01.

4.2. Récupérer les données de marées

Se connecter au site : http://www.tides.gc.ca/fra

Section Archives
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Hydrographe ! Une carriere d’avenir CIDCO

nment  Gouw

Péches et Océans Canada

Sur I'eau Péches Science et recherche Ecosystémes Espéces Aquaculture Régions

Accueil * Sur 'eau * Conditions maritimes * Marées, courants et niveaux d'eau

Marées, courants et niveaux d'eau
Cliquez sur la région désirée. ..

|Marées, courants et niveaux d'eau | [

Informations générales
Les marées et courants

Histoire
References verticales

Phénomeénes particuliers

Données disponibles P
Predictions

Observations

Prévisions océaniques

Index des localités

. ou choisissez dans la liste

iGlossaire
arctique j Aller

Les niveaux d'eau au bout des doigts!

Carte interactive.
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Hydrographe ! Une carriere d’avenir CIDCO

Péches et Océans Canada

Sur I'eau Péches Science et recherche Ecosystémes Espéces Aquaculture Régions

Accueil » Science et recherche » Sciences » GDSI » MCNE > Archives

Archives canadiennes des données sur les marées
et niveaux d’eau

GDSI

Le Centre national des données du Canada contient plus de 500 millions de saisies
Argo dans ses archives des données historiques sur les marées et niveauxr d'eau; les plus
BioChem anciennes datent de la période précédant I'avénement du sigcle. Plus de deusx millions
Boudes dérivantes d'observations recueillies au moyen du réseau permanent d'observations du sont
Cartes interactives st Services de cartes rajoutées quotidiennement et mensuellement. Les données sont également échangées
I sur une base annuelle avec Environnement Canada,
CLIVAR plus
Contaminants
Formats de codes et avis du SMT Données et pdeUitS
GTSPP + Liste des stations canadiennes et téléchargement de données
JCOMM
Liste des codes Données catiadiennes sur les marées et niveaux d'eau. Informations sur les

‘ stations, inventaire des données numérigues sur les données des niveaux d'eau

‘Marees Bt niveaux d'eau disponibles pour téléchargement.

Mormes

Demander les données de marées au maréegraphe de Saint-Francois de I'lle d’Orléans.

(175 Elan | Satellite
e 138} -
< >
v Station: 3100
Mom de station : Saint-Francois 10
ry
{ Emplacement : 47-70.81
[ﬁ] Région : Quebec

Afficher l'inventaire
Wendake .

Sainte-Anne—dé'-Beaupré | y P
sainte-Brigitte-de-Laval c

i i35 9

Chéteau-Richer

|I
ac-Beauport

. Saint-Jean-de-Iiile-d'Orléans
s:zLauren tides B
i o

%/ recherche Sene ( ): 2 e st Ostas i sndOosas caris
CIDCO Québec Cégep Limoilou o -



Hydrographe ! Une carriere d’avenir CIDCO

Les données dans I'inventaire de la station

Station 3100

| | Retour & la carte Descriptions des champs

N

Informations sur la station

Nom de station: Saint-Francois 10
Numeéro de station: 3100
Latitude (Décimal): 4699652 M

Longitude {Décimal): 70.8081879 W

Code Datum: cb

Fuseau horaire: EST

Etat: PERMANENT

Temps du dernier mise a jour: 2012/8/21 3:51:26 PM

Demander les données de marées horaires, en heure Locale pour la période du 22 au 24
novembre 1999.

Les données dans I'inventaire de la station

Station 3100

Betour 3 la cal

Si vous choisissez "Données & haute résolution” parmi les résolutions disponibles, lintervalle de temps doit &tre un mois ou moins.,
Si vous choisissez "Données horaires", l'intervalle de temps doit &tre dix ans ou moins.Pour les moyennes journaliéres ou
maoyennes mensuelles, il n'y a pas de limite de donneées que vous pouvez telécharger

Informations sur les données

Date début (AAAA/MM/IT) Date fin (AAAA/MM/1T)
1999/11/22 1999/11/24

Résolution

* Données au haut resalution
' Données horaires
' Moyenne journaliére

Fuseau horaire

= Locale

[ iSoumettre: |

Télécharger le fichier 3100-22-NOV-1999_slev.csv.
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Hydrographe ! Une carriere d’avenir CIDCO

Les données dans | inventaire de la station

Station 3100

Informations sur la station

MWom de Station: Saint-Francois 10
Muméro de Station: 3100

Latitude (Décimal): 46.9965
Longitude {Dé&cimal): 70.808167

Code de Datum: ch

Fuseau horaire: EST

Données sur la station

Le fichier de données a crée, cliguer sur le nom de fichier pour télécharger.
Nom de fichier:
Taille de fichier: 4575 bytes

Ouvrir le fichier 3100-22-NOV-1999_slev.csv dans un éditeur de texte.

Nom de 3tation,3aint-Francois I0
Numéro de Station,3100
Latitude (Décimal),46.3965
Longitude (Décimal) ,70.305167
Code de Datum,CD

Fuseau horaire,E3T

SLEV=Niveau d'ean
Date_d'Dhservatinn,SLEvimétres]
1999711722 00:00,0.83,
1999711722 00:15,1.13,
1999711722 00:30,1.52,
1999/11/22 00:45,1.921,
1999711722 01:00,2.24,

Reformater le fichier suivant la convention Caris pour les fichiers de marées (.tid)

1999/11/22 00:00 0.83
1999/11/22 00:15 1.13
1999/11/22 00:30 1.52
1999/11/22 00:45 1.91
1999/11/22 01:00 2.24

Renommer le fichier Marees_StFrancois_19991123 Locale.tid
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Hydrographe ! Une carriere d’avenir CIDCO

Ouvrir le fichier de marées ainsi créé dans le Caris Tide Editor E’—“

* F\Projets',1213-723 Nova-Science_SensibilisationHydrog - | Ellﬂ

|
|F:'|,Projets'|,1213-?23 MNowa-Science_SensibilisationHydrographiel ActivikeF

JJ File Edit Wiew Tools Help

DS HE || e

|1999£11£22 |1999£11£23

00 00 00 I I an 15 00 0 ¢

- Time Interval

HH:MM 0000 ate [Time [Tide (m) | ﬂ
Da_',' ] 24:00 1 1999,|'11,|'22 00:00:00 0,830
1 1 z 1999/11/22 00:15:00 1.130
I-I ﬁ J 3 199911022 00:30:00 1.520
4 199911022 00:45:00 1.910
- Tide Scale 5 19991122 01:00:00 2,240
_ 0 5] 1999/11/22 01:15:00 2.580
&0 7 199911022 01:30:00 2.890
= g 199911022 01:45:00 3.200
2= 7 9 1999/11/22 02:00:00 3.490 LI
Reary [ 4
4.3. Appliquer le fichier de marées au jeu de données
bathymétriques
Sélectionner toutes les | =-I2 Alcor

lignes de sondage dans
la fenétre Control
(onglet Project)
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Hydrographe ! Une carriere d’avenir

CIDCO

Process
=>» Load Tide...

| Process Select Window

tew Field Sheet
Set as Achive Field She

‘m Load True Heave. ..
& Load Dela Draft...

Browse : Naviguer
jusqu’au fichier
Marees_StFrancois_
19991123 Locale.tid

Tide File

I F:lProjets!1213-723 Nova-acience_SensibilisationHydr:

Edit. .. |

™| weighted averaging I™ | Compute errors

Load || Cancel I

Browse,

Help

Process
= Merge

| Process Select Mindow

Mew Field Sheet
Set as Gekive Field St

'°>=v\ Load True Heave. ..
? Load Delta Draft. ..
ﬁ) Load Tide...

Load attitude/Mavigat

Load Error data. ..

4,_3|I Compute TPU. ..
£ Compute GPS Tide...
“tk Sound Yelocity Correc

Clic droit sur la couche
SA_3m
= Recompute

----- [« Density
----- W]« Depth
..... |:|¢ Mean

----- [« shoal

----- [« std_Dev

----- [0 Bounding Polygon

—
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= et Technologie
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Hydrographe ! Une carriere d’avenir CIDCO

5. Corriger les données pour le probleme d’acquisition #2 (bras
de levier GPS/sondeur)

5.1. Mesurer l'erreur sur le bras de levier GPS/sondeur

Tools |I|:||:||5 Process Select Window Help
> Subset ¢ Batch Processor... | E'El .
Editor
Gttitude Editor .
= Open e . gt E

Sensoh Layout, ..

J;‘ M awigation Editor
Set Interpolation, ..
Shift Mawigation, ..

Single Beam Editor ¥
Swwath Editor k
|pdate Backscatter

Subset Editor J

Dessiner la fenétre 'ﬁ - - "

du Subet Editor dans | &
une zone de dunes a -
la perpendiculaire

Augmenter
I’exagération

verticale (environs
15)

Subset Editor - 2D ¥iew

10.00 30,00 40,00 F0.00 go.on 100.00 110,00
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Hydrographe ! Une carriere d’avenir CIDCO

Tools |I|:||:||5 Process Select Window Help
> Measure ¢ Batch Processor...
Distance
oFe gttitude Editor

Sensoh Layout, ..

J;‘ M awigation Editor
Set Interpolation, ..
Shift Mawigation, ..

Single Beam Editor ¥
Swwath Editor k
|pdate Backscatter

Subset Editor »
Mew subset Tiles, ..

Zalibratian, ..

Mosaic Editar r
Side Scan Editar *
Bearn Paktbern Cotreckion k

= Set Filters. .,
Apply Filters »

Surface Cleaning r

Measure Distance

En mesurant la distance entre les crétes successives suivant deux lignes de sondage de sens
opposé sur le méme relief, on trouve un déphasage d’environs 5m qui traduit une erreur de bras
de levier GPS/sondeur de 2.5m.

5.2. Modifier le Vessel File pour corriger I'’erreur de bras de levier

(GPS/sondeur)
Sélectionner le =03 Aloor
vaisseau (GC03) dans la - ELRIIEY
fenétre Control (onglet

Project)
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Hydrographe ! Une carriere d’avenir

CIDCO

Sélectionner le |g.:|it YWiews Tools Proce
vaisseau (GCO3) dans la 3 Undo
fengtre Control (onglet T Restart Cleaning...
Project)
& Cut
By Copy

Copy Position

B Paste

Delete

Bemarne

Skatus Elag
Q@ CIuery
guery Line
Accepk Line
Reject Line

Classify Lines. ..

&k Find...

Zolours, .,

Tiles
Lidar

Sélectionner I'onglet - Sweep
Navigation - Mavigation

Ligne 8, colonne Y # () ¥ () Zim}

inscrire -2.5 0,000 -0,400 -11.300
0.000 -0.400 -11.300
0.000 -1.500 -11.300
0.00a -0.400 -11.300
0.00a -1.500 -11.300
0,000 -2,500 -11.300
0,000 0.660 -11.300
0,000 -2.5 -11.300
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Hydrographe ! Une carriere d’avenir CIDCO

Process | Process Select  Window
> Merge ew Field Sheet
Set as Ackive Field St

% Load True Heave. ..
fi& Load Dela Draft...
& Load Tide. .,

Load akkitude/Mavigat

Load Error data. ..

4|_E|I Cornpute TPU. ..
$3 Compute GPS Tide...
" Sound Yelocity Correc

Clic droit sur la couche
SA_3m
= Recompute

---- [J«% shoal
---- [J«% std_Dev
----- |:|_,_ Bounding Polygon
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Hydrographe ! Une carriére d’avenir CIDCO

6. Interpoler la Surface Base corrigée

Clic droit sur la couche v 1 ™ .
SA 3m <[ Recompute
= Interpolate... <l .
DI Finalize...
<1 Interpolate. ..
-~
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Hydrographe ! Une carriére d’avenir CIDCO

Interpolate Surface x|

Source Surface: 54_3m

Destination Surface: |5.-5'-._3m_l nterp

Fatns size: © Ix 3

Murnber Of Heighbours: |E
k. | Cancel | Help
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